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Введение

Выполнение лабораторных и контрольных работ является неотъемлемым этапом освоения программы технических дисциплин при обучении в ВУЗе.

В настоящих методических указаниях представлен материал для выполнения четырех лабораторных работ для студентов дневной формы обучения и двух контрольных работ для студентов заочной формы обучения по дисциплине «Архитектура и проектирование программного обеспечения».
Методические указания разработаны на основе квалификационных требований, предъявляемым к специалистам в области программной инженерии, компьютерных наук, системной инженерии, и соответствуют требованиям Министерства образовании и науки, молодежи и спорта Украины. При составлении методических указаний был обобщен многолетний опыт преподавания дисциплин, связанных с изучением архитектуры и проектирования программного обеспечения, в ДонНТУ.
1 Цели и задачи лабораторных и контрольных работ
Цели выполнения работ:

· систематизировать, закрепить и расширить теоретические знания по изучаемой дисциплине;

· закрепить и развить навыки самостоятельного решения задач в области проектирования программного обеспечения;

· развить навыки выполнения научных исследований и творческие способности в области проектирования программного обеспечения.

Основная задача выполнения работ – подготовка студентов к самостоятельной практической инженерной деятельности в области проектирования программного обеспечения с применением существующих моделей и шаблонов проектирования на основе знаний, полученных в процессе обучения в ВУЗе.

Лабораторные и контрольные работы являются самостоятельной работой студента. За все принятые в лабораторных и контрольных работах технические решения и правильность всех данных несет ответственность студент – автор работ.

2 Организация выполнения лабораторных и контрольных работ

В ходе работы студент на занятиях, а также самостоятельно изучает  инфор​мацию по заданию, делает заметки, выписки, состав​ляет необходимые алгоритмы, диаграммы, классы и программы и отлаживает их на ЭВМ.

Преподаватели делают отметки о выполненной работе. Студент может посещать консультации согласно установленного графика (но не сдавать на них работы).

Лабораторные и контрольные работы рекомендуется выполнять в соответст​вии с графиком, приведенным в таблице 2.1.
Таблица 2.1 – Этапы, результаты и сроки выполнения работ

	№
	Этапы и результат работы
	Срок выполнения

(№ недели)

	
	Очная форма обучения
	Заочная форма обучения
	

	Модуль 1

	1
	Получения задания на ЛР № 1
	Получения задания на КР № 1
	1-2

	2
	Выполнение и сдача ЛР № 1
	Выполнение и сдача КР № 1
	3-4

	3
	Получение задания на ЛР № 2
	
	5-6

	4
	Выполнение и сдача ЛР № 2
	
	7-8

	Модуль 2

	6
	Получение задания на ЛР № 3
	Получения задания на КР № 2
	10-11

	7
	Выполнение и сдача ЛР № 3
	Выполнение и сдача КР № 2
	12-13

	8
	Получение задания на ЛР № 4
	
	13-14

	9
	Выполнение и сдача ЛР № 4
	
	15-16


3 Лабораторная работа. Изучение среды разработки Eclipse и архитектуры ввода-вывода Java
3.1 Теоретические сведения
Eclipse - это расширяемая среда разработки (Integrated Development Environment, далее IDE) с открытым исходным кодом.
Платформа Eclipse в сочетании с JDT включает многие из возможностей, которые включаются в коммерческие IDE: редактор с подсветкой синтаксиса, инкрементальная компиляция кода, потокобезопасный отладчик, навигатор по классам, менеджеры файлов и проектов, а также интерфейсы к стандартным системам контроля исходных текстов, таким как CVS и ClearCase.
3.2 Изучение среды Eclipse

Интерфейс

После установки Eclipse окно первого запуска вы должны увидеть окно, похожее на это:
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Рисунок 2. Первоначальный вид окна Eclipse

 

Как вы можете видеть у Eclipse довольно стандартное меню:
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и панель инструментов:
[image: image3.png]|w

o

R A




Также имеется многостраничный редактор с закладками, в настоящий момент показывающий страницу навигатора:
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Приложение-пример

На экране присутствуют Файловый Навигатор (Navigator), Список Текущих Задач (Tasks) и Группировщик Кода (Outline), но пока что не содержат никакой информации. Для продолжения нашего исследования Eclipse, мы создадим простое приложение калькулятора на базе Swing.

1. Чтобы начать создание первого Java-проекта, выберите File->New->Project... В левом списке появившегося мастера выберите Java Project. Затем нажимите кнопку Next.
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Рисунок 3. Первая страница мастера Нового Проекта

2. В качестве названия проекта введите Calculator и снова нажмите Next. Можно указать место для хранения исходных и скомпилированных файлов, а также создать отдельные каталоги для таких файлов.
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Рисунок 4. Вторая страница мастера Нового Проекта

 

3. Последний шаг мастера позволяет указать место для хранения исходных и скомпилированных файлов, а также задать любые подпроекты и библиотеки, которые могут понадобиться для работы и компоновки текущего проекта.
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Рисунок 5. Третья страница мастера Нового Проекта

4. Щелкните на кнопке Finish. В появившемся окошке предлагающем переключить перспективу жмем на YES и Eclipse создаст новый проект.

После создания проекта, вы можете обратить внимание на то, что окно Eclipse выглядит не совсем так, как вначале: представление Outline переместилось в правую часть окна, Navigator был заменен на Package Explorer и так далее.
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Рисунок 6. Перспектива Java

Новый внешний вид носит название Перспективы Java. Перспектива, в терминах Eclipse, это сохраняемый внешний вид окна, включающий любое число редакторов (editors) и представлений (views). В поставку Eclipse входит несколько перспектив по умолчанию (Java, Debug, Resource и так далее), которые можно настраивать. Вы также можете создавать новые перспективы. Перспективы управляются с помощью элементов меню Window или панели инструментов, которая обычно располагается вдоль левой границы окна Eclipse. 
Следующим шагом в создании нашего Java проекта станет создание папок, в которых будет содержаться исходный код. Переключитесь в перспективу ресурсов (Resource) с помощью Window->Open Perspective->Other. В представлении Навигатора Файлов раскройте дерево папок и найдите узел src. Выберите этот узел, а затем пункт меню File->New->Folder. В открывшемся диалоге убедитесь, что выбрана папка src, затем введите com в поле Folder Name.

Создание большого числа папок с использованием диалога New Folder может показаться несколько неудобным. К счастью, Eclipse позволяет сделать эту работу, используя методы, принятые в вашей операционной системе: командную оболочку, Windows Explorer и так далее. Воспользуйтесь одним из этих методов и создайте подпапки devious и calculator в папке com. после этого выберите любую папку в представлении Навигатора, а затем пункт меню File->Refresh. Eclipse просмотрит файловую систему и приведет проект в соответствие с внесенными изменениями. На данный момент наш проект должен выглядеть примерно так:
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Рисунок 7. Создание папок завершено

 
И последнее замечание по созданию файлов: на ранних этапах разработки проекта вы можете столкнуться с необходимостями часто запускать код на выполнение, создавать новые файлы или папки, добавлять новый код, компилировать и тестировать его снова. Важно помнить, что меню Eclipse отображается по-разному в зависимости от текущей перспективы. Таким образом, если вы переключаетесь в перспективу ресурсов для создания новых файлов или папок через представление Навигатора, вы обнаружите, что например, меню Run заметно отличается от аналогичного меню в перспективе Java. Одним из решений данной проблемы может послужить использование пункта меню Window->Show View и отображение представления Навигатора в перспективе Java. Чтобы закрепить это изменение, используйте команду меню Window->Save Perspective As..., позволяющее сохранить настройки перспективы под новым именем или заменить настройки существующей перспективы Java.

Добавление кода

Теперь, когда мы построили структуру папок, мы можем начать добавлять код к нашему проекту. Мы разделим нашу программу калькулятора на три отдельных файла кода: CalcMode.java, CalcPanel.java и Calculator.java.

 

CalcModel.java
package com.devious.calculator;

 

import java.util.Observable;

 

public class CalcModel extends Observable

{

    public static final int OP_NONE = 0;

    public static final int OP_ADD  = 1;

    public static final int OP_SUB  = 2;

    public static final int OP_MUL  = 3;

    public static final int OP_DIV  = 4;

 

    private int pendingOp = 0;

    private int previousValue = 0;

    private int currentValue = 0;

 

    public String getValue()

    {

        return Integer.toString(currentValue);

    }

    public void addDigit(String s)

    {

        char c = s.charAt(0);

        String val = getValue() + c;

        setDisplay(Integer.parseInt(val));

    }

    public void addDigit(char c)

    {

      String val = getValue() + c;

      setDisplay(Integer.parseInt(val));

    }

    public void setOperation(int op)

    {

        if (pendingOp != OP_NONE)

            calculate();

        previousValue = currentValue;

        this.pendingOp = op;

        currentValue = 0;

    }

    public void setDisplay(int value)

    {

        currentValue = value;

        setChanged();

        notifyObservers();

    }

    public void clear()

    {

        this.pendingOp = OP_NONE;

        previousValue = 0;

        setDisplay(0);  

    }

    public void calculate()

    {

        switch (pendingOp)

        {

        case OP_ADD:

            setDisplay(previousValue + currentValue);

            break;

        case OP_SUB:

            setDisplay(previousValue + currentValue);

            break;

        case OP_MUL:

            setDisplay(previousValue * currentValue);

            break;

        case OP_DIV:

            setDisplay(previousValue / currentValue);

            break;

        } 

        pendingOp = OP_NONE;

        previousValue = 0;

    }

}

 

CalcPanel.java
 
package com.devious.calculator;

 

import javax.swing.*;

import java.awt.*;

import java.awt.event.*;

import java.util.*;

 

public class CalcPanel

      extends JPanel

      implements ActionListener, Observer

{

    private CalcModel model;

    private JLabel display = new JLabel("0");

    public CalcPanel(CalcModel model)

    {

        super();

        this.model = model;

        model.addObserver(this);

    }

    protected JButton addButton(String label)

    {

        JButton b = new JButton(label);

        b.addActionListener(this);

        return b;

    }

    protected JPanel createButtonPanel()

    {

        JPanel panel = new JPanel();

        panel.setLayout(new GridLayout(0, 4));  

       

        panel.add(addButton("1"));

        panel.add(addButton("2"));

        panel.add(addButton("3"));

        panel.add(addButton("+"));

       

        panel.add(addButton("4"));

        panel.add(addButton("5"));

        panel.add(addButton("6"));

        panel.add(addButton("-"));

       

        panel.add(addButton("7"));

        panel.add(addButton("8"));

        panel.add(addButton("9"));

        panel.add(addButton("*"));

       

        panel.add(addButton("C"));

        panel.add(addButton("0"));

        panel.add(addButton("="));

        panel.add(addButton("/"));

 

        return panel;

    }

    public void init()

    {

        this.setLayout(new BorderLayout());

        display.setVerticalTextPosition(JLabel.CENTER);

        display.setHorizontalTextPosition(JLabel.RIGHT);

        display.setVerticalAlignment(JLabel.TOP);

        display.setHorizontalAlignment(JLabel.TRAILING);

        display.setBorder(BorderFactory.createLineBorder(Color.black));

       

        this.add(display, BorderLayout.NORTH);

        this.add(createButtonPanel(), BorderLayout.CENTER);

    }

    public void actionPerformed(ActionEvent evt)

    {

        System.out.println(evt.paramString());

        try {

            switch (evt.getActionCommand().charAt(0)) {

            case '+':

                model.setOperation(CalcModel.OP_ADD);

                break;

            case '-':

                model.setOperation(CalcModel.OP_SUB);

                break;

            case '*':

                model.setOperation(CalcModel.OP_MUL);

                break;

            case '/':

                model.setOperation(CalcModel.OP_DIV);

                break;

            case '=':

                model.calculate();

                break;

            case 'C':

                model.clear();

                break;

            default:

                model.addDigit(evt.getActionCommand());

                break;

            }

        } catch (NumberFormatException ex) {}

    }

    public void update(Observable o, Object arg)

    {

        display.setText(model.getValue());

    }

   

}

 
Calculator.java
package com.devious.calculator;

 

import javax.swing.*;

 

public class Calculator

{

    public static void main(String[] args)

    {

        try {

            UIManager.setLookAndFeel(

                UIManager.getCrossPlatformLookAndFeelClassName());

        } catch (Exception e) {}

 

        JFrame calcFrame = new JFrame("Calculator");

       

        CalcModel model = new CalcModel();        

        CalcPanel calcPanel = new CalcPanel(model);

        calcPanel.init();

                

        calcFrame.setContentPane(calcPanel);

        calcFrame.setDefaultCloseOperation(JFrame.EXIT_ON_CLOSE);

        calcFrame.pack();

        calcFrame.setVisible(true);

    }

}

 
Создайте и поместите эти файлы в подпапку com/devious/calculator. Используйте команду File->Refresh для обновления проекта Eclipse.
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Рисунок 8. Проект с добавленными исходными файлами

 
CalcPanel.java обрабатывает большую часть пользовательского интерфейса нашего калькулятора. Calculator.java отвечает за настойку графического интерфейса и его отображение. Большая часть важной работы обеспечивается файлом CalcModel.java, который реализует непосредственно "механику" калькулятора: реакцию на события, производство числовых вычислений, обновление окна и так далее. Самый простой путь исследования кода заключается в переключении в перспективу Java или в перспективу Просмотра Java (Java Browsing). Используйте элемент меню Window->Open Perspective или нажмите кнопку Open на "перспективной" панели инструментов.

При использовании Package Explorer для просмотра исходного кода вы можете заметить, что представление группировки кода является избыточным. Чтобы его закрыть, нажмите на значок х в заголовке его окна. При необходимости отобразить его снова, используйте команду меню Window->Show View->Outline.
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Рисунок 9. Перспектива просмотра Java Browsing
Запуск кода и отладка

Итак установили Eclipse, создали Java-проект, добавили папки и файлы, необходимые для работы простого приложения. Самое время посмотреть, как оно будет работать. Для выполнения последующих инструкций по запуску приложения вам нужно будет перейти в перспективу Java:

1.      Из меню Run выберите элемент Run...
2.      В появившемся диалоге из списка Конфигураций Запуска (Launch Configurations) выберите "Java Application", затем нажмите на кнопку New.

 
[image: image12.png]Creste, manage,andrun conlgrations

@ Montype ot oechied 0

N [ oz

& 07 Jova pcaen

O o o s | 3 4 Gt | S| 78 e o]
T eeeeee——

i
|
T ——,
I i bt mans v s foc s s

I stpmmsn

[ L B
==





Рисунок 10. Диалог Run

3.      Введите Calculator в качестве имени (Name) новой конфигурации.

4.      Нажмите кнопку Search... и выберите Calculator в качестве главного класса (Main Class) введите в текстовом поле com.delirious.calculator.Calculator.
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Рисунок 11. Выбор главного класса

4. Щелкните кнопку Run для сохранения конфигурации и запуска приложения.
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После того как вы создали конфигурацию запуска приложения, вы можете запускать его многократно и использованием элемента меню Run->Run History или кнопки Run на панели инструментов. Если вы потратите достаточно времени, забавляясь с калькулятором, вы обратите внимание на то, что несмотря на нормальную в целом работу, у него имеется один большой недостаток - он не выполняет вычитание. Время использовать отладчик исходного кода Eclipse и найти проблему. Если вы выполняли все шаги, описанные в статье, вы можете отладить приложение в той конфигурации запуска, которая была создана ранее. Выберите в меню Run->Debug History->Calculator для запуска приложения в отладчике.

3.3 Средства форматированного ввода/вывода Java
В качестве средства форматированного ввода/вывода в Java можно использовать класс StringTokenizer.

Класс StringTokenizer похож по названию и назначению на класс StreamTokenizer, однако работает не с потоками, а с текстовыми строками. Вы можете использовать класс StringTokenizer для выделения элементов строк класса String.

В классе StringTokenizer предусмотрено три конструктора:

public StringTokenizer(String str);

public StringTokenizer(String str,

  String delim);

public StringTokenizer(String str,

  String delim, boolean returnTokens);

В качестве первого параметра конструкторам передается ссылка на разбираемую строку. Второй параметр delim, если он есть, задает разделители, с использованием которых в строке будут выделяться элементы. Параметр returnTokens определяет, надо ли возвращать обнаруженные разделители как элементы разбираемой строки.

Методы класса StringTokenizer перечислены ниже:

public String nextToken();

public String nextToken(String delim);

public int countTokenss();

public boolean hasMoreElements();

public boolean hasMoreTokenss();

public Object nextElement();

Для разбора строки приложение обычно создает цикл, вызывая в нем метод nextToken. Условием завершения цикла может быть либо возникновение исключения NoSuchElementException, либо возврат значения false методами hasMoreElements или hasMoreTokens.

Метод countTokens позволяет определить, сколько раз был вызван метод nextToken перед возникновением исключения NoSuchElementException.

String s = "Строка, которую мы хотим разобрать на слова"; 

StringTokenizer st = new StringTokenizer(s, " \t\n\r,."); 

while(st.hasMoreTokens()){

// Получаем слово и что-нибудь делаем с ним, например,

// просто выводим на экран

System.out.println(st.nextToken()) ; 

}
Полученные слова обычно заносятся в какой-нибудь класс-коллекцию: Vector, Stack или другой, наиболее подходящий для дальнейшей обработки текста контейнер.

 4 Лабораторная работа. Разработка клиента COM-сервера
4.1 Теоретические сведения
Сервер COM является приложением или библиотекой, которая предоставляет сервис клиентскому приложению (или библиотеке). Сервер включает по крайней мере один объект COM, который в свою очередь представляет собой совокупность методов и свойств. Клиент не обязан знать, где в памяти располагаются объекты COM.
Когда клиент запрашивает сервис у объекта COM, он (клиент) должен передать идентификатор класса CLSID (class identifier). Идентификатор класса CLSID создается на основе GUID интерфейса объекта COM.

По идентификатору класса CLSID COM определяет соответствующий сервер, загружает его в память и сервер создает экземпляр объекта COM. Экземпляры объектов COM создает фабрика классов (class factory), к которой обращается сервер. Фабрика классов имеет свой интерфейс IClassFactory.

Фабрика классов и класс CoClass. COM объект является экземпляром класса CoClass, в котором реализованы один или более интерфейсов COM. Объект COM обеспечивает те сервисы, которые определены в интерфейсах класса CoClass.

Экземпляры класса CoClass создаются специальным типом объекта, который называется фабрикой класса. Когда клиент обращается к COM объекту, фабрика класса создает экземпляр объекта и регистрирует экземпляр объекта для этого конкретного клиента. Если в это время другой клиент обращается к объекту, фабрика классов для него также создает (другой) экземпляр объекта.

Любой класс CoClass должен иметь фабрику классов и идентификатор класса CLSID, так что экземпляр COM объекта этого класса может быть создан извне, т.е. из другого модуля. Благодаря наличию у классов CoClass уникального идентификатора CLSID, они могут быть обновлены в любое время, как только для класса разработан новый интерфейс. Новый интерфейс может использовать модифицированные или новые методы и это не оказывает никакого влияния на прежние версии. В случае использования обычных библиотек DLL подобная ситуация прежде была типичной проблемой.

Способы реализации COM-серверов
При работе с объектами COM клиент не знает, где находится объект. Он просто обращается к объекту посредством его интерфейса. Далее библиотека COM выполняет все необходимые шаги для удовлетворения вызова клиента.

Эти шаги зависят от конкретного местонахождения объекта COM: в том же процессе, что и клиент, в другом процессе на машине клиента или на другой машине в сети. В зависимости от этого различают три вида серверов COM.

Сервер в клиентском процессе (In-process server). Это библиотека DLL, которая выполняется в адресном пространстве процесса клиента. Например, элемент ActiveX, внедренный в Web страницу, выполняется в Internet Explorer или другом браузере. Это значит, что объект ActiveX загружается на машину клиента и выполняется в том же процессе, что и Web браузер. Клиент обращается к объекту COM путем прямого вызова интерфейса COM.
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Рис. Сервер в клиентском процессе
Локальный сервер (local server). Он представляет собой другое приложение (файл *.exe), которое выполняется в другом адресном пространстве, но на том же компьютере, что и клиентское приложение. Например, обработка таблицы Excell, внедренной в документ Word, выполняется приложением Excell. Локальный сервер связывается с клиентом посредством COM библиотек.
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Рис. Локальный сервер
Когда объект COM принадлежит другому процессу на том же компьютере, что и клиентское приложение, или вовсе на другом компьютере (в сети), COM использует так называемого "заместителя" (proxy) для того, чтобы инициировать удаленный вызов процедуры (remote procedure call – RPC). Так как заместитель находится в клиентском процессе, то с точки зрения клиента обращения к интерфейсам выглядят так же, как и для случая размещения сервера в клиентском процессе. Заместитель перехватывает вызовы клиента и отправляет их туда, где находится сервер. Механизм, который позволяет клиенту получить доступ к объекту, находящемуся в другом процессе или на другом компьютере (невидимо для клиента), называется маршалингом или маршализацией.
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COM
Удаленный сервер (remote server). Он представляет собой библиотеку (DLL или OCX) или другое приложение, которые выполняются на другом компьютере, а не на машине клиента. Например, клиентское приложение, использующее базу данных, связывается с приложением, выполняемым на другом компьютере в сети. В этом случае удаленный сервер использует интерфейсы DCOM.



Рис. Удаленный сервер
Различие между локальным и удаленным сервером состоит в применяемом способе (и инструментальных средствах) взаимодействия клиента и сервера: в первом случае используется COM, а во втором – DCOM.

Если сервер реализован как библиотека (а библиотека не может выполняться как самостоятельное приложение), то COM создает специальное приложение-суррогат (surrogate), в рамках которого и выполняется библиотека.

Маршалинг. Механизм маршалинга позволяет клиентскому приложению делать вызовы методов интерфейса для объекта COM, который находится в другом процессе или на другом компьютере.

При любом вызове функций посредством интерфейса клиентское приложение помещает фактические параметры функции в стек и выполняет ее вызов. Если функция не находится в клиентском процессе, то вызов передается заместителю. Заместитель упаковывает параметры в пакет и передает их удаленному объекту. Заглушка COM объекта распаковывает пакет, помещает аргументы в стек и вызывает объект COM. Таким образом объект COM обрабатывает запрос клиента в своем собственном адресном пространстве.

Какой именно маршалинг будет реализован, зависит от реализации COM объекта. Стандартный механизм реализован интерфейсом IDispatch. Кроме того, объекты могут самостоятельно выполнять маршалинг, однако это довольно сложно.

Отметим, что технология Microsoft Transaction Server (MTS) обеспечивает дополнительную поддержку для удаленных объектов.

4.2 Пример реализации и использования COM-класса в С++

В этом разделе рассматривается весь процесс создания локального СОМ объекта, реализованного непосредственно в приложении.

Описание класса IUnknown:

struct IUnknown

{

virtual HRESULT STDMETHODCALLTYPE QueryInterface(

/* [in] */ REFIID riid,

/* [iid_is][out] */ void __RPC_FAR *__RPC_FAR *ppvObject)=0 ;

virtual ULONG STDMETHODCALLTYPE AddRef( void) =0;

virtual ULONG STDMETHODCALLTYPE Release( void) =0;

};

Смысл использованных макросов:

HRESULT – long;

STDMETHODCALLTYPE – _stdcall

REFIID – const GUID &

Описание (базового) класса IAccount – наследника IUnknown – как абстрактного класса:
class IAccount : public IUnknown

{

public:

// IAccount methods

STDMETHOD(GetBalance)(int* pBalance) = 0;

STDMETHOD(Deposit)(int amount) = 0;

};

8. Здесь STDMETHOD – virtual HRESULT _stdcall.

Описание (конкретного) класса СAccount:

class CAccount : public IAccount

{

public:

CAccount() // конструктор
{

m_nRef = 0;

m_nBalance = 100;

}

// методы IUnknown

STDMETHOD(QueryInterface)(REFIID, void**);

STDMETHOD_(ULONG, AddRef)();

STDMETHOD_(ULONG, Release)();

// IAccount methods

STDMETHOD(GetBalance)(int* pBalance);

STDMETHOD(Deposit)(int amount);

protected:

ULONG m_nRef; // число ссылок

int m_nBalance; // счет в банке

};
Использованные макросы:

9. REFIID – GUID (структура из 16 байт);

10. STDMETHODIMP – HRESULT _stdcall.

11.
Реализация методов класса CAccount:
STDMETHODIMP

CAccount::QueryInterface(REFIID iid, void** ppv)

{

if (iid == IID_IUnknown)

*ppv = (IAccount*) this;

else if (iid == IID_IAccount)

*ppv = (IAccount*) this;

else

{

*ppv = NULL;

return E_NOINTERFACE;

}

AddRef();

return NOERROR;

}
Метод QueryInterface в конечном итоге возвращает ссылку на таблицу vtable, которая создается компилятором С++ автоматически, если в классе определены виртуальные функции.
STDMETHODIMP_(ULONG) CAccount :: AddRef()

{

return ++m_nRef;

}

STDMETHODIMP_(ULONG) CAccount :: Release()

{

if(--m_nRef == 0)

{

delete this; // уничтожение экземпляра класса
// Trace("Object destroyed", "CAccount");

return 0;

}

return m_nRef;

}

STDMETHODIMP CAccount :: Deposit(int amount)

{

m_nBalance += amount;

return S_OK;

}

STDMETHODIMP CAccount::GetBalance(int* pBalance)

{

*pBalance = m_nBalance;

return S_OK;

}
Для практического использования класса CAccount требуется описать экземпляр класса IAccount:
IAccount * m_pAccount=NULL;

и получить ссылку на интерфейс. Эту задачу решает (обычная) функция CreateAccount.

BOOL CreateAccount(IAccount ** ppAccount)

{

HRESULT hr;

if (ppAccount == NULL)

return FALSE;

// Create object

CAccount* pAccount = new CAccount;

if (pAccount == NULL)

return FALSE;

// получить интерфейс. При этом в QueryInterface вызывается метод AddRef

hr = pAccount->QueryInterface(IID_IAccount, (void**) ppAccount);

if (SUCCEEDED(hr))

{

Trace("Object created", "CAccount");

return TRUE;

}

else

{

delete pAccount;

return FALSE;

}

}
Идентификатор интерфейса можно получить с помощью GuidGen и описать его как константу, например:
static const IID IID_IDisplay =

{ 0x5723b700, 0x2878, 0x11d1, { 0xa0, 0x1b, 0x0, 0xa0, 0x24, 0xd0, 0x66, 0x32 } };

Идентификатор для интерфейса IUnknown предопределен.

Невзирая на то, что в функции CreateAccount указатель pAccount на экземпляр класса создается локально, объект может быть разрушен, так как ссылка на него сохраняется в параметре ppAccount. Экземпляр СОМ класса уничтожается в методе Release.

Вызов этой функции целесообразно выполнить следующим образом:
if (m_pAccount)

{

m_pAccount->Release();

m_pAccount = NULL;

}

// создание экземпляра СОМ класса

if (!CreateAccount(&m_pAccount))

{

MessageBox("CreateAccount failed");

return;

}
После получения ссылки на интерфейс ею можно пользоваться для вызова методов класса, например, так:
int balance;

HRESULT hr = m_pAccount->GetBalance(&balance);

if (FAILED(hr))

{

MessageBox("GetBalance failed");

return;

}
Добавление других интерфейсов. Для реализации дополнительных интерфейсов необходимо проделать следующие шаги:

Ø объявить новый (абстрактный) класс как производный от IUnknown;

Ø сгенерировать для него идентификатор IID с помощью GuidGen.exe;

Ø объявить конкретный класс как производный от всех поддерживаемых объектом СОМ интерфейсов.

Например:

class IDisplay : public IUnknown

{

public:

// IDisplay methods
STDMETHOD(Show)() = 0;

};

Теперь используем множественное наследование и описываем класс конкретный:

class NewCAccount : public IAccount, IDisplay

{

…

}

Так как появился дополнительный интерфейс, необходимо изменить реализацию QueryInterface так, чтобы он позволял получать любой из интерфейсов IAccount и IDisplay. Пример реализации этого метода:

STDMETHODIMP

CAccount::QueryInterface(REFIID iid, void** ppv)

{

if (iid == IID_IUnknown)

*ppv = (IAccount*) this;

else if (iid == IID_IAccount)

*ppv = (IAccount*) this;

else if (iid == IID_IDisplay)

*ppv = (IDisplay*) this;

else

{

*ppv = NULL;

return E_NOINTERFACE;

}

AddRef();

return NOERROR;

}
 5 Лабораторная работа. Использование технологии XML в Java приложениях
Целью работы является изучение XML (eXtensible Markup Language) и способов обработки XML-данных с помощью парсеров SAX и DOM. 

Задачи: 

1) Необходимо разработать программу, согласно варианта задания из таблицы№1(номер по журналу mod количество вариантов+1), которая позволяет манипулировать данными посредством загрузки и выгрузки из XML-файла.

2) Парсер SAX реализуют студенты с четным номером варианта.

3) Парсер DOM реализуют студенты с нечетным номером варианта.

Таблица 1

	№
	Задание

	1
	Телефонная книга

	2
	Адресная книга

	3
	Курс валют за неделю

	4
	Прогноз погоды на неделю

	5
	Библиотека

	6
	Расписание движения транспортных средств

	7
	Расписание занятий


6 Лабораторная работа. Создание Web-сервисов
Цель работы:  Приобрести навыки создания Web-сервисов и распределенных приложений.

Контрольные вопросы:

1. Что называется Web-сервисом?

2. Перечислите стандарты для Web-сервисов.

3. Что такое SOAP?
4. Что такое WSDL?
5. Что такое UDDI?
6. Что такое XML? Как используется в Web-сервисах?

7. Какое расширение имеют файлы Web-сервисов?

8. Какой формат возвращаемых данных используется в Web-сервисах (службах)?

9. Можно ли использовать Доступ к БД из Web-сервисов?

10. Какую роль играет имя ссылки на службу в Windows-приложении?

11. Порядок регистрации Web-сервиса.

12. Порядок использования Web-сервиса.

13. Приведите примеры, где можно использовать Web-сервисы.

14. Перечислите достоинства и недостатки Web-сервисов.

Задание

1. Создать и протестировать поисковый Web-сервис по конкретной предметной области. Необходимо:

· реализовать передачу пользовательской части поискового запроса в качестве параметра в Web-метод(ы) Web-сервиса;

· реализовать валидацию (проверка на пустоту и наличие пробелов) входного поискового запроса; 

· реализовать возврат результатов поиска в качестве результатов выполнения Web-метода(ов) Web-сервиса, обосновать тип возвращаемого значения.
2. Создать и протестировать клиент, использующий Web-сервис. Необходимо

· реализовать ввод пользовательской части поискового запроса;

· результаты работы Web-сервиса отобразить в виде списка первых 10 релевантных ссылок;

· при вызове Web-методов Web-сервиса использовать механизм асинхронного вызова.

Варианты

Предметная область

1. Поиск по сайтам, входящим в доменную зону com.ua.

2. Поиск по сайтам, входящим в доменную зону gov.ua.

3. Поиск по сайту http://forum.ixbt.com/.

4. Поиск по сайту http://rsdn.ru/.

5. Поиск по сайту http://msdn.microsoft.com/.

Клиент (по выбору студента)
1. Windows Forms Application.

2. ASP .NET Web Application.

3. ASP .NET Web Site.

Выбор варианта по каждому из параметров осуществляется по формуле:
Номер-зачетки MOD Количество-вариантов + 1
Содержание отчета:

1. Титульный лист.

2. Цель, задание, вариант.

3. Пример SOAP и HTTP POST запросов и ответов для любого Web-метода Web-сервиса, принимающего параметры и возвращающего результат.

4. Описание метода решения задачи, входных и выходных данных.

5. Листинг исходного кода файла класса Web-сервиса с комментариями.

6. Листинг исходного кода клиента, предназначенного для тестирования Web-сервиса, с комментариями.

7. Экранная форма клиента в процессе тестирования Web-сервиса.

8. Выводы.

Перечень ссылок:

1 Andreas Eide, «Professional ASP.NET Web Services», Wrox Press, 2001

2 Michael Stiefel, «Application Development Using C# and .NET» Prentice Hall,2001

3 Andrew Krowczyk, «C# Web Services. Building WS with .Net Remoting and ASP.Net», Wrox Press, 2001

4 www.rsdn.ru
5 www.msdn.com
6 www.gotdotnet.com
7 Контрольные работы для студентов заочной формы обучения

Студенты заочной формы обучения самостоятельно выполняют контрольные работы и оформляют по ним отчеты. Оформление отчета должно соответствовать «Положению о контрольных работах для студентов заочной формы обучения». Порядок предоставления выполненных работ в ВУЗ и их оценивания изложен в вышеуказанных положениях.

В качестве заданий на контрольные работы студенты заочной формы обучения используют задания на лабораторные работы для студентов дневной формы обучения в соответствии с данными в таблице 7.1.

Таблица 7.1 – Формирование заданий для студентов заочной формы обучения

	№
	Тема работы
	Вид работы
	Задание
	Контроль

	1. 
	Изучение среды разработки Eclipse и архитектуры ввода-вывода Java
	Контрольная работа № 1
	Задание к лабораторной работе № 1
	Отчет сдается в деканат

	2. 
	Разработка клиента COM-сервера
	Контрольная работа № 2
	Задание к лабораторной работе № 2
	Отчет сдается в деканат

	3. 
	Использование технологии XML в Java приложениях
	Самостоятельное изучение
	Задание к лабораторной работе № 3
	На экзамене

	4. 
	Создание Web-сервисов
	Самостоятельное изучение
	Задание к лабораторной работе № 4
	На экзамене


Во время выполнения работ студенты заочной формы обучения могут использовать методические указания к выполнению лабораторных работ.

7 ВОПРОСЫ КУРСА
Модуль 1

1. Архитектура ПО 

2. Повторное использование кода в формировании архитектуры

3. Образцы инженерной деятельности при анализе, проектировании, реализации ПО 

4. Типовые решения, шаблоны, их типы

5. Структура описания шаблона

6. Идиомы программирования 

7. Описание и реализация простейших идиом на С++ и Java на примере увеличения счетчика 

8. Описание и реализация простейших идиом на С++ и Java на примере обмена объектов 

9. Описание и реализация простейших идиом на С++ и Java на примере повтора действий

10. Шаблонное программирование на С++

11. Шаблоны анализа. Использование диаграмм классов для представления результатов анализа предметной области

12. Шаблоны проектирования 

13. Порождающие шаблоны проектирования 

14. Структурные шаблоны проектирования 

15. Поведенческие шаблоны проектирования

16. Шаблон проектирования Abstract Factory

17. Шаблон проектирования Builder, 

18. Шаблон проектирования Factory Method

19. Шаблон проектирования Prototype

20. Шаблон проектирования Singleton

21. Шаблон проектирования Adapter интерфейса класса

22. Шаблон проектирования Adapter интерфейса объекта

23. Шаблон проектирования Bridge

24. Шаблон проектирования Composite

25. Шаблон проектирования Decorator

26. Шаблон проектирования Facade

27. Шаблон проектирования Flyweight

28. Шаблон проектирования Proxy

29. Шаблон проектирования Chain of Responsibility

30. Шаблон проектирования Command

31. Шаблон проектирования Interpreter

32. Шаблон проектирования Iterator

33. Шаблон проектирования Mediator

34. Шаблон проектирования Momento

35. Шаблон проектирования Observer
36. Шаблоны организации поведенческого взаимодействия объектов

37. Сравнительный анвлиз шаблонов проектирования Iterator и Visitor

38. Сравнительный анвлиз шаблонов проектирования Composite и Decorator

39. Сравнительный анвлиз шаблонов проектирования Factory Method и Template Method

40. Схема реализации шаблона Singleton
41. Шаблон проектирования State

42. Шаблон проектирования Strategy

43. Шаблон проектирования Template Method

44. Шаблон проектирования Visitor
45. Веб-сервер. Веб-приложение. 

46. Тонкий клиент. Толстый клиент. RIA-приложение

Модуль 2

1. Архитектурный стиль “Конвейерная обработка данных”. 

2. Архитектурный стиль “Пакетная обработка данных”. 

3. Архитектурный стиль “Каналы и фильтры”. 

4. Архитектурный стиль “Замкнутый цикл управления”.

5. Архитектурный стиль “Рабочий процесс“ (workflow).

6. Архитектурный стиль “Вызов-возврат“. 

7. Архитектурный стиль ”Процедурная декомпозиция”. 

8. Архитектурный стиль “Абстрактный тип данных“ .

9. Архитектурный стиль “Многоуровневая система“.

10. Архитектурный стиль “Клиент-сервер“.

11. Архитектурный стиль “Интерактивная система“. 

12. Архитектурный стиль ”Данные-представление-обработка” (MVC).

13. Архитектурный стиль ”Представление-абстракция-управление”.

14. Архитектурный стиль ”Системы на основе хранилища данных”.

15. Архитектурный стиль ”Репозиторий”.

16. Архитектурный стиль ”Классная доска”.

17. Архитектурный стиль ”Удаленный вызов процедуры” (RPC).

18. Архитектурный стиль “Очередь сообщений”.

19. Архитектурный стиль “Пакетная обработка данных”. 

20. Архитектурный стиль “Каналы и фильтры”. 

21. Архитектурный стиль “Клиент-сервер“.

22. Архитектурный стиль “Многоуровневая система“.

23. Архитектурный стиль ”Данные-представление-обработка” (MVC).

24. Архитектурный стиль ”Удаленный вызов процедуры” (RPC).

25. Архитектурный стиль “Абстрактный тип данных“ .

26. Подходы к классификации архитектур. Слой. Уровень (звено).

27. Однозвенная архитектура. Клиент-сервер.

28. Двузвенная архитектура клиент-сервер. 

29. Файловый сервер. 

30. Сервер БД. Хранимые процедуры.

31. Веб-сервер. Веб-приложение. 

32. “Тонкий“ клиент. “Толстый клиент“. RIA-приложение.

33. Трехзвенная архитектура клиент-сервер. Сервер приложений.

34. Трехзвенная архитектура клиент-сервер. Сервер транзакций.

35. Трехзвенная архитектура клиент-сервер. Сервер сообщений.

36. Трехзвенная архитектура клиент-сервер. Сервер с брокером объектных запросов.

37. Принцип ACID (Atomicity, Consistency, Isolation, Durability).

38. Пятизвенная архитектура клиент-сервер.

39. Промежуточное ПО. Архитектура промежуточного программного обеспечения. Классификация ППО. 

40. Промежуточное ПО. ППО БД. Коммуникационное ППО. Платформенное ППО.

41. Синхронное и асинхронное взаимодействие, удаленный вызов процедур, транзакция. 

42. Различия в реализации вызова RPC и обмена сообщений в архитектуре клиент-сервер.

43. Архитектура Web-приложения. Использование MVC. 

44. Web-сервисы. Сервис-ориентированная архитектура. 

45. Технологии  XML-RPC и SOAP. WSDL.

46. Архитектура платформы .NET Framework. CLR, CTS, CLS, MIL. 

47. Модель компонентного объекта  и протоколы удаленного взаимодействия DCOM, RMI, CORBA.

48. Компонентные технологии и разработка распределенного ПО. Программный компонент, интерфейс, программный контракт.

49. Компонентная модель, компонентная среда, базовые службы компонентной среды, распределенное ПО, прозрачность, открытость, масштабируемость, безопасность. 

50. Компонентные технологии: определение, назначение, использование. Роль интерфейса в компонентной технологии.

51. Технология COM: описание модели компонентного объекта, интерфейс, кокласс.

52. Недостатки COM.

53. COM клиент и COM сервер.

54. Интерфейс IUnknown, реализация пользовательского интерфейса, UML диаграмма классов кокласса.

55. GUID, типы идентификаторов, диаграмма взаимодействия при поиске сервера, использование в методах интерфейсов  IUnknown и IClassFactory.

56. Модель ошибок в COM, использование HRESULT.

57. Фабрика класса, ее назначение и использование.

58. Интерфейс IClassFactory, использование метода CreateInstance.

59. Получение указателя интерфейса через QueryInterface, использование методов интерфейса, освобождение указателя интерфейса.

60. Жизненный цикл кокласса, управление временем жизни кокласса с использованием AddRef и  Release, диаграмма взаимодействия фабрики и кокласса.

61. Прозрачность местонахождения в модели COM: GUID, идентификаторы
интерфейса и кокласса, ProgID, реестр, схема нахождения и загрузки сервера, CoCreateInstance.

62. Контейнер DLL, функции DllGetClassObject, DllCanUnloadNow, Dll(Register|Unregister)Server, схема регистрации COM-сервера.

63. Внутрипроцессный сервер COM.

64. Локальный сервер COM.

65. Удаленный сервер COM, RPC, прокси, заглушка, маршаллинг.

66. Языковая независимость в модели COM, информация о типе, формат 
описания IDL, типы данных. 

67. Схема генерации ПО с использованием IDL на примере библиотеки MSXML.

68. Формат документа XML: элемент, атрибут, комментарий, сущность, пространство имен, CDATA.

69. Правила оформления документа XML, XHTML.

70. Определение типа документа DTD, валидация документа XML.

71. Парсер документа XML DOM-парсер документа XML SAX-парсер документа XML.

72. Архитектура push - парсера XML-документа.

73. Архитектура pull - парсера XML-документа.

74. Архитектура DOM - парсера XML-документа.

75. Архитектура XSLT- процессора XML-документа.
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